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Features

The BZPS-8000 System Management Software (referred 
to as “System Manager”) provides overall management 
control of MVS-8000/DVS-9000-series switcher systems 
connected to a network (Data LAN), in a server/client 
relationship.
The following are the principal features of System 
Manager.

Effective Use of Setup Data

The setup data for all devices (center control panel, 
switcher processor, and DME processor) making up the 
system can be held and managed by System Manager. You 
can return the saved setup data to the original device as 
required, or pass it to similar devices. This allows a custom 
system for particular studio purposes to be created quickly.

File Management for Setting Data

You can copy the setting data files from one device to 
another, or from one studio to another. This allows 
effective use of snapshots, keyframe effects, and other 
setting data.

Remote Operation of Switcher Menu

With the optional BZPS-8001 Switcher Setup Software 
installed, you can operate the Engineering Setup menu and 
other switcher menus using a computer in place of the 
center control panel.

Installation

This section describes the installation procedure for the 
BZPS-8000 System Management Software and the 
optional BZPS-8001 Switcher Setup Software.
Note that the CD used for installation is assumed to include 
both BZPS-8000 and BZPS-8001.

Installing the BZPS-8000 System 
Management Software

First install the Java 2 Runtime Environment, then install 
BZPS-8000.

Installing the Java 2 Runtime Environment

1 Insert the CD containing the BZPS-8000 and BZPS-
8001 software into the CD drive of the computer.

If the CD drive window opens automatically, skip to 
step 3; otherwise continue to step 2.

2 Start Windows Explorer, and select the CD drive 
(sys_manager).

The CD drive window opens.

3 The CD drive window shows a list of files: double-
click on the v1.0 folder.

A list of the three files within the folder appears: j2re-
1_4_0_01-windows-i586-i (Java 2 Runtime 
Environment install file), setup8000, and setup8001.

4 Double-click on the j2re-1_4_0_01-windows-i586-i 
file.

The program starts reading in the files required to 
install the Java 2 Runtime Environment, and when the 
5Features
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reading-in is completed, the following InstallShield 
Wizard dialog box appears.

5 Click the Next button.

The License Agreement window appears.

6 If you agree to the terms of the license agreement, 
click the Yes button.

The Choose Destination Location window appears.

7 Click the Next button.

The Select Browsers window appears.

8 Click the Next button.

The Setup Status window appears, and the setup 
progress is shown.

When the setup operation completes, the InstallShield 
Wizard dialog box automatically closes.
This completes installation of the Java 2 Runtime 
Environment.
Next install the BZPS-8000 software.

Installing BZPS-8000

1 In the Windows Explorer CD drive window, double-
click the [setup8000] file in the list of files.

After a window indicating that preparations for 
installation are in progress appears, the following 
BZPS-8000 - InstallShield dialog box appears.
Installation
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2 Click the Next button.

The Customer Information window appears. In the 
User Name box, the computer name automatically 
appears.

3 In the License Key box, enter the license key number, 
and under “Install this application for:” click either of 
the option buttons, “Anyone who uses this computer 
(all users)” or “Only for me”, then Click the Next 
button.

The Destination Folder window appears.

4 Click the Next button.

The Ready to Install the Program window appears.

5 Click the Install button.

The window changes to indicate that installation is in 
progress, and when the installation is completed, the 
InstallShield Wizard Completed window appears.

6 Click the Finish button.
7Installation
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This closes the BZPS-8000 - InstallShield dialog box, 
and a System Manager icon for launching the program 
appears on the desktop.

Installing the BZPS-8001 Switcher 
Setup Software

The process of installation is basically the same as that for 
the BZPS-8000 software described in the previous section. 
There are the following three differences:
• In step 1, double-click the setup8001 folder.
• In step 3, in the License Key box enter the license key 

number for the BZPS-8001 software.
• When installation is completed, no icon for launching 

the BZPS-8001 software appears on the desktop.

Starting System Manager

Double-click the System Manager icon on the desktop.
Once the program starts, you must log on. (See “Logging 
On” on page 9.)

Buttons Common to Most Windows

This section describes the operation of buttons common to 
most windows and dialog boxes in System Manager.

As an example, the following is the System Manager Main 
Menu window.

a  (minimize) button
Clicking this button minimizes the window, showing it as 
a button on the taskbar.

b  (maximize) button 
Clicking this button maximizes the window to full-screen.

c  (close) button 
Clicking this button closes the window.

1  button

2  button

3  button
Installation
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Logon and User
Registration
Logging On

When you start System Manager, the LogOn dialog box appears.

To log on, carry out the following operation in the LogOn dialog box.

1 In the Server box, enter the server IP address or host name.
If it is already registered, you can select from the drop-down list.

The IP address or host name you enter is automatically registered at logon. 
You can register a maximum of five entries.

2 In the LogOn Name drop-down list, select the logon name (user name).

If you have started System Manager for the first time
The logon name is set to Administrator, and this step is not required. Skip 
to step 4.

3 Enter the password in the Password box.

4 Click the Log On button.
9Logging On
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This completes the logon process. An automatic scan starts, and the 
following window appears.

For details of the scan operation, see the section, “Checking Devices With 
IP Address Registered — Scan” (page 24).

When the scan operation is completed, the System Manager Main Menu 
window appears.

For details of the Main Menu window, see the section, “Names and 
Functions of Parts of the Main Menu Window” (page 11).

If you have logged on for the first time
Next, register the users. (See “User Registration” on page 14.)

Canceling a logon
Click the Exit button or  button of the LogOn dialog box. This closes the 
LogOn dialog box, and exits System Manager.
Logging On
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Names and Functions of Parts of the Main Menu Window

The Main Menu window provides a portal to the various functions offered by 
the BZPS-8000 System Management Software and BZPS-8001 Switcher Setup 
Software. It also functions as the exit from System Manager after using the 
BZPS-8000 and BZPS-8001 functions.
The following shows names and functions of parts of the Main Menu window.

a File
Click this to display the File menu. The File menu provides 
the following commands.
About: Shows version information for System Manager.
Setup: Opens the Setup of System Manager dialog box, to 

make user name, password, and permissions settings. 
This command is only available if you logged on as 
Administrator.

Log Off: Click to switch to a different server without 
exiting System Manager. The LogOn dialog box 
appears.

Exit: Exits System Manager.

b Device Monitor
Clicking this starts Device Monitor (See Chapter 3).

c File Manager
Clicking this starts File Manager (See Chapter 4).

d Switcher Setup
When the optional BZS-8001 Switcher Setup Software is 
installed, clicking this starts the Switcher Setup Software 
(See Chapter 5).

e Status bar
This shows the result of the automatic scan carried out 
after logon.
If the devices connected to the network are detected 
without problem, the message “Device scan finished.” 
appears.
If there are problems detecting devices, an error message 
appears. In this case, start Device Monitor, and use the 
Scan function to investigate.

For details of the scan operation, see the section, 
“Checking Devices With IP Address Registered — Scan” 
(page 24).

Checking the Version Information

To check the System Manager version information, in the Main Menu window 
File menu, select About.

1 File

3 File Manager

2 Device Monitor

4 Switcher Setup

5 Status bar
11Logging On
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The version information appears in a window as follows.

To close this window, click the  button or  button.

Exiting System Manager

To exit System Manager, in the Main Menu window File menu, select Exit, or 
click the  button.

This closes the Main Menu window, and any other windows and dialog boxes 
opened in this session, then exits System Manager.

Next time you start System Manager and log on, the windows and dialog boxes 
will automatically open in the same positions as in the previous session.
Logging On
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Switching to a Different Server — Log Off

After logging on, you can switch to a different server without exiting System 
Manager.
Use the following procedure.

1 In the Main Menu window File menu, select Log Off.

The LogOn dialog box appears.

2 Select a different server, and log on.

For details of logging on, see “Logging On” (page 9).
13Switching to a Different Server — Log Off
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User Registration

Overview

Use of System Manager is restricted to those with user names registered with 
System Manager.
Each user is given Administrator permissions or Operator permissions.
A user with Operator permissions can log on to System Manager, and create 
files and carry out other operations, but there are restrictions, for example on 
accessing files created by other users. In contrast, a user with Administrator 
permissions (referred to as an “administrator”) can carry out the following, in 
addition to the operations allowed for users with Operator permissions.
• Registering users.
• Accessing any files created by other users.

Registering Users

This section describes procedures which can only be carried out by an 
administrator, for user registration and setting user permissions.
To make the settings, use the following procedure.

1 Log on as administrator.

For details of logging on, see “Logging On” (page 9).

When the automatic device scan is completed, the System Manager Main 
Menu window appears.

2 In the Main Menu window File menu, select Setup.

The Setup of System Manager dialog box appears.
User Registration
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3 Set the permissions.

• To set the Administrator permissions, click the Administrator option 
button, turning it on.
In the User Name box, Administrator appears. Skip to step 5.

• To set the Operator permissions, click the Operator option button, turning 
it on. Continue to step 4.

4 Enter the user name in the User Name box.

The user name can be a maximum of 30 characters.

5 Enter the password in the Password box.

The password can be a maximum of 30 characters.

6 In the Confirm password box, enter the same password you entered in step 
5.

7 Click the  button.

This confirms the setting, and the user is registered.
The registered user name appears in the User Name column of the User list, 
and the user’s permissions appear in the LogOn Class column.

If a password error message appears
If there is a problem with the password setting, an error message appears. 
Follow the directions under the next item, “Password errors”.

8 Repeat steps 3 to 7 for all the users to be registered.

Password errors
• If no password is entered, the following message box appears.
15User Registration
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Click the OK button or  button to close the message box, and carry out 
steps 5 to 7.

• If the passwords entered in the Password box and the Confirm password box 
do not match, the following message box appears.

Click the OK button or  button to close the message box, and carry out 
steps 5 to 7 again.

To close the Setup of System Manager dialog box
Click File within the dialog box, then in the displayed drop-down menu select 
Close. Alternatively, click the  button in the top right corner of the window.

Deleting a Registered User

To delete a registered user, use the following procedure.

1 In the User Name display, select the user name to delete.

2 Click the “– Delete” button.
User Registration
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With Device Monitor, you can carry out the following operations for the devices 
connected to the network.
• Check that all devices with IP address registered with System Manager are 

present on the network and that they can be connected to the Data LAN.
• Register the IP address of an additional device.
• Divide the devices into groups, for group management.
• Take setup data from any particular device, and return it to the original device, 

or pass to another device.

Starting Device Monitor

To start Device Monitor, in the System Manager Main Menu window, click 
Device Monitor.

This starts Device Monitor, and opens the Device Monitor window.
The first time you log on, the results of the automatic scan after logon appear in 
this window as follows.
17Overview
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This window display shows that one each center control panel, switcher 
processor, and DME processor (this combination is referred to as the “standard 
configuration”) is present on the network, and that these are assigned to a group 
called “OTHER”. Where the status of each device in the Status column shows 
“<-New!”, this indicates that the device was newly recognized by the automatic 
scan. If you save the scan results, from the next time, this “<-New!” disappears.

For details of how to save the scan results, see page 24.

To check devices outside the standard configuration
When you first log on, even if devices outside the standard configuration are 
connected to the network, the presence of these devices is not detected by the 
automatic scan. To check devices outside the standard configuration, carry out 
a “Discovery” operation (see page 21).

Group icon

List of devices Status column
Starting Device Monitor
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Names and Functions of Parts of the Device Monitor Window

a File
Click this to display the File menu. The File menu provides 
the following commands.
Scan: Carry out a scan. (See page 24.)
Discovery: Carry out the “Discovery” operation. (See 

page 21.)
Save: Save scan results. (See page 24.)
Close: Close the Device Monitor window.

b Setup
Click this to display the Setup menu. The Setup menu 
provides the following command.

IP Address: Displays the Setup - IP Address dialog box, 
in which you can register device IP addresses. (See 
page 22.)

c Group
Click this to display the Group menu. The Group menu 
provides the following commands.
Add: Create a new group.
Delete: Delete the selected group.
On: Display group icons. 
Off: Do not display group icons.

For details of groups, see the section, “Creating Groups” 
(page 26).

1File

2Setup

3Group

4Get

5Put

6Scan status display area

7Group icon display

8Status bar

9List of devices
19Starting Device Monitor
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d Get
Click this to display the Get menu. The Get menu provides 
the following command.
Get: Get the device setup data, and save it on the System 

Manager hard disk. (See page 30.)

e Put
Click this to display the Put menu. The Put menu provides 
the following command.
Put: Transfer device setup data saved on the System 

Manager hard disk to the original device, or to another 
device of the same type.  (See page 34.)

f Scan status display area
This shows an icon for System Manager on the right, and 
device icons on the left. During a scan, pink broken lines 
emanate from the System Manager icon, indicating the 
progress of the scan.

g Group icon display
When the Group menu has “On” selected, this shows the 
group icons.

h Status bar
This shows the status of a Scan/Discovery operation.

i List of devices
This shows the devices in each group.
Icon column: This shows the device icon. To select a 

device to move to a different group, or to transfer setup 
data, click on this icon.

IP Address column: This shows the device IP address.
Device Name column: This shows the device name.
Description column: This shows an identifier or similar 

for the device. You can enter up to 30 characters.
Comment column: This shows comments. You can enter 

up to 30 characters.
Status column: This shows the results of a Scan/

Discovery operation.

Exiting Device Monitor

To exit Device Monitor, in the Device Monitor window File menu select 
[Close], or click the  button.
Starting Device Monitor
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Checking Devices With an Unregistered IP Address — 
Discovery

To allow devices newly connected to the network to be controlled by System 
Manager, it is first necessary for Device Monitor to be aware of the existence of 
these devices, and then to register the device IP addresses.

To carry out a Discovery operation
In the Device Monitor window File menu, select Discovery.

This starts the Discovery operation.
During the Discovery operation, the Device Monitor window status bar shows 
the message: “Now Scanning...”
When the Discovery operation ends, the message “Device scan finished.” 
appears in the status bar, and any devices discovered appear in the list of 
devices. In the Status column in the list, the indication “<- New!” appears.
21Checking Devices With an Unregistered IP Address — Discovery
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Registering a Device IP Address

To register a device IP address, use the following procedure.

Note 
If before carrying out this procedure you carry out a Discovery operation (see 
previous item), you can enter the IP addresses while referring to the IP Address 
column in the list of devices.

1 In the Device Monitor window Setup menu, select IP Address.

The Setup - IP Address dialog box appears.

2 In the IP address input boxes of the Setup - IP Address dialog box, enter the 
numeric values.

IP address input boxes
Registering a Device IP Address
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Use the rightmost box to enter a consecutive series of IP addresses in a 
single operation. For example, to register the three IP addresses 10.129.1.2, 
10.192.1.3, and 10.192.1.4, enter “10.129.1.2 to 4”.

3 Click the  button.

This registers the entered IP address (or addresses), which appear in the list 
at the top of the dialog box.

To delete an IP address once registered
Select the icon for the device to be deleted in the list, and click the “– Delete” 
button.

To close the Setup - IP Address dialog box
Click the  button in the top right corner or the  button at the lower right.
23Registering a Device IP Address
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Checking Devices With IP Address Registered — 
Scan

In a scan operation, you can check that all devices whose IP address is registered 
are present on the network and that they can be connected to the Data LAN.
Carry out a scan after adding or removing a device on the network (adding or 
deleting an IP address).

To carry out a scan
In the Device Monitor window File menu, select Scan.

The scan starts.
During the scan, the Device Monitor window status bar shows the message: 
“Now Scanning...”
When the scan ends, the message “Device scan finished.” appears in the status 
bar, and the scan results appear in the list of devices.
• When a device is recognized for the first time in this scan (when the IP address 

was not registered in the previous scan), the Status column in the list of 
devices shows “<- New!”

• For a device which was not found in this scan, the Status column in the list of 
devices shows “<- Not Found!” or “<- Removed!”
The following are possible reasons for the “<- Not Found!” message:
– The device is not currently connected to the network.
– The device is powered off.
The message “<- Removed!” means that the IP address of the device has been 
deleted.

Saving the Scan Results

To save the scan results, use the following procedure.

1 In the File menu, select Save.
Checking Devices With IP Address Registered — Scan
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2 When the save operation completes normally, the following message box 
appears. Click the OK button.
25Checking Devices With IP Address Registered — Scan
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Creating Groups

When there is a large number of devices in the network, it is convenient to 
divide them into a number of groups.
For example, if the devices for three studios are separated into respective groups 
A, B, and C, then you can set up all of the devices in group A in one operation, 
then transfer the settings to group B or C. This immediately sets the devices in 
group B or C to the same settings as the devices in group A.
When a group is no longer needed, you can delete the group itself, which 
removes the registration of all devices in this group from System Manager.

To create a group, in the Device Monitor window use the following procedure.

1 In the Group menu, select Add.

This creates a new group with the name “Unnamed”, whose icon appears 
in the group display.

2 Select the devices to belong to the newly created group (click the device 
icon shown in the Icon column in the list of devices), and drag onto the icon 
for the new group.

Created group
Creating Groups
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This removes the selected device from the original group (in this example 
the default group “OTHER”), and moves it into the new group.

Other Operations on Groups

Switching to a different group
The list of devices in the Device Monitor window shows only the devices 
belonging to the currently selected group.
To display the devices belonging to a different group, click the group icon to 
select it. The selected group icon changes from a gray to a white background.
27Creating Groups
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Changing a group name
You can change an existing group name to any desired name of up to 30 
characters.
To change the group name, in the Device Monitor window use the following 
procedure.

1 Double-click the icon for the group whose name you want to change (e.g. 
“Unnamed”).

A frame appears around the group name on the icon, enabling character 
input.

2 Enter the name from the keyboard, and press the Enter key.

Deleting a group
You can delete a group whenever it is no longer required.
Click the icon for the group to be deleted, to select it, then in the Group menu 
select Delete.

Toggling the display of group icons on or off
To display the group icons, in the Group menu select “On”; to not display them, 
select “Off”.
Creating Groups
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Getting Device Setup Data — Get

You can load the setup data for any device into System Manager, and save it in 
a folder. Then it is possible to return the saved setup data to the original device 
as required, or pass it to similar devices in the same group or other groups.

To get the device setup data, use the following procedure.

1 In the Device Monitor window, select the device (click a device icon within 
the list of devices).

2 In the Get menu, select Get.

The Get window appears.
• If there are existing folders for storing setup data in System Manager, a 

list appears in the window. To save the data in an existing folder, 
continue to step 3.

• To save in a new folder, follow the procedure in the section “Creating a 
folder” (page 32) to create the folder, then continue to step 3.
Getting Device Setup Data — Get
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3 In the Get window, select the folder in which you want to save the data, and 
click the  button.
(To cancel the operation, click the  button.)

The Get window changes to a Confirmation window prompting you to 
confirm the get operation.

4 Click the  button in the Confirmation window.
(To cancel the operation, click the  button.)
31Getting Device Setup Data — Get
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The get operation starts, and the Confirmation window changes to a Get 
window showing the progress of the transfer.

When the transfer is completed, the Get window automatically closes.

To cancel the transfer after it has started
Click the  button.

Creating a folder
To create a folder in which to save the data, use the following procedure.

1 Click the  button in the Get window.

A dialog box for setting the new folder name appears. In the name input 
box, the current date appears as the name of the new folder.
Getting Device Setup Data — Get
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2 • If you want to use the date as the folder name, click the OK button.
• To use a name other than the date, enter a name of up to 30 characters 

from the keyboard, and click the OK button.
(To cancel creating the folder, click the Cancel button.)

This creates the folder, and the name appears in the Get window.

Note 
Once you have created a folder, you cannot delete it or change its name 
within Device Monitor. To delete or rename a folder, you must use File 
Manager (see Chapter 4) or Windows Explorer.
33Getting Device Setup Data — Get
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Transferring Setup Data to a Device — Put

To return setup data saved in System Manager to the original device, or transfer 
it to similar devices, use the following procedure.

1 In the Device Monitor window, select the device to which you want to 
transfer the data (click a device icon within the list of devices).

2 In the Put menu, select Put.

The Put window opens, and the list of folders created when getting data 
appears.
Transferring Setup Data to a Device — Put
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3 In the Put window, select the folder containing the data you want to transfer 
to the device, and click the  button.
(To cancel the operation, click the  button.)

The Put window changes to a Confirmation window prompting you to 
confirm the put operation.

4 Click the  button in the Confirmation window.
(To cancel the operation, click the  button.)
35Transferring Setup Data to a Device — Put
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The put operation starts, and the Confirmation window changes to a Put 
window showing the progress of the transfer.

When the transfer is completed, the Put window automatically closes.

To cancel the transfer after it has started
Click the  button.
Transferring Setup Data to a Device — Put
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Overview

File Manager provides basic functions for System Manager. Use it to manage 
setting data files for devices in the network. It allows FTP file transfers to 
devices connected to the Data LAN.
You can use it as a file backup function.

Starting File Manager

To start File Manager, in the System Manager Main Menu window, select File 
Manager.

File Manager starts, and the File Manager window appears.

For details of the File Manager window, see the next section, “Names and 
Functions of Parts of the File Manager Window”.
37Overview
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Names and Functions of Parts of the File Manager Window

a File
Click this to display the File menu. The File menu provides 
the following commands.
Close: Close the File Manager window, and exit File 

Manager.

b Frame Memory
Click this to display the Frame Memory menu. In this 
menu, select whether transfers of switcher data should 
include bulky frame memory data. To include it, select 
“On”, and to exclude it select “Off”.

c Data LAN folder display
This shows a tree representation of the data folders and 
data files for devices connected to the Data LAN. Select a 
folder here.
The  mark on the left of the folder icon indicates that 
other folders or files are held within this folder. Clicking 
this changes it to a  mark, and the folder contents 
appear.

d Data LAN file list
This shows a list of files stored in the selected folder in the 
Data LAN folder display. Select files here.

1File

5Get button

2Frame Memory

3Data LAN folder display 4Data LAN file list

8System Manager folder display

6Put button

7System Manager file list

0 button

9 button
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e Get button
Use this to get a device setting data file.

f Put button 
Use this to transfer a setting data file held in System 
Manager to a device.

g System Manager file list
This shows a list of files stored in the selected folder in the 
System Manager folder display. Select files here.

h System Manager folder display
This shows a tree representation of the folders in the 
System Manager hard disk. Select a folder here.

i (delete) button
This deletes the selected folder in the System Manager 
folder display, or the selected files in the System Manager 
file list.

j  (new) button
This creates a new folder on the System Manager hard 
disk.

Exiting File Manager

To exit File Manager, in the File menu select Close, or click the  button in 
the upper right corner of the window.
39Starting File Manager



40

C
hapter 4  F

ile M
anager
Getting Device Setting Data Files — Get

This section describes the procedure for transferring the setting data file for a 
device you want to save to the System Manager hard disk.

1 In the Data LAN folder display, select the folder in which the file you want 
to get is stored.

As an example, here the folder “CH1” is selected, holding the snapshot data 
files for DME channel 1.

This starts reading in of the file list, and the following window appears.

To cancel the reading in, click the  button.
Getting Device Setting Data Files — Get
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When the file list has been read in, the Data LAN file list shows the list of 
files within the folder.

The  mark to the left of a file name indicates that the file exists, whereas 
a  mark indicates that the file does not exist.

2 In the System Manager folder display, select the Administrator folder or 
user folder in which you want to save the file.

The user folder is identified by the same name as the registered user name. 
Here, by way of example, the user folder “COMMON” is selected.

Notes 
• Only an Administrator can select the Administrator folder. Note that an 

Administrator can select any folder.
• A registered user with Operator permissions cannot select a different 

user’s user folder.

3 Click the  button.

(You can also click the Get button at this point. In this case, for the 
following procedure see the note under the heading “If in step 3 you clicked 
the Get button in place of the  button” on page 43.)

A destination folder with the current date as its name is created. You can 
change the name to a different name of up to 30 characters. To confirm the 
name, press the keyboard Enter key.
41Getting Device Setting Data Files — Get
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4 Click the Get button.

A Confirmation window appears, prompting you to confirm the operation.

5 Click the  button in the Confirmation window.
(To cancel the operation, click the  button.)

The get operation starts, and the Confirmation window changes to a Get 
window indicating that the file is being transferred.
Getting Device Setting Data Files — Get
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When the transfer is complete, the System Manager display in the File 
Manager window changes as follows.

To cancel the get operation after it has started
Click the  button.

If in step 3 you clicked the Get button in place of the  
button
The following message box appears.
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Clicking the OK button creates a destination folder with the current date as its 
name, and starts the transfer of files.

Getting All of the Device Setting Data Files

In the Data LAN folder display, selecting the topmost folder for a device allows 
you to get all of the setting data files for the device.

Further, selecting a group folder allows you to get all setting data files for up to 
six devices (up to two switchers + up to four DMEs) belonging to that group.

DME

Center control panel

Switcher
Getting Device Setting Data Files — Get
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When a device is not supported by System Manager
If a device is not supported, it is not possible to get the setting data file. For 
example, if the device at IP address 10.129.1.1 is an unsupported type of center 
control panel, clicking the Get button produces the following message box.

If you select a group for the get operation
The status of the data transfer for each device appears in the Get window.

Group
45Getting Device Setting Data Files — Get
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Time required to transfer files
To transfer all data files from a switcher takes about 7 minutes, while 
transferring all data files from a DME takes about 5 minutes.
When both switcher and DME are selected, the entire processing is completed 
in the longer required time (approximately 7 minutes for the switcher).

To cancel the get operation after the transfer has started
Click the  button.

Specifying Whether To Include Frame Memory Data in the Transfer

When getting a switcher data file, you can specify whether or not to include 
bulky frame memory data.
To make the specification, click Frame Memory, and in the drop-down menu 
select “On” (transfer) or “Off” (do not transfer).

During transfer of 
switcher setting file

During transfer of DME 
setting file

Device at this address is 
not supported, and data 
could not be obtained
Getting Device Setting Data Files — Get
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Deleting a Folder or File That Has Been Obtained

After a get operation, you can delete a folder or file that is not required.
Use the following procedure.

1 In the System Manager folder display/file list, select the folder or file you 
want to delete.

2  Click the  button.

A confirmation window prompts you to confirm the deletion. Click the OK 
or Cancel button.
47Getting Device Setting Data Files — Get
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Transferring Device Setting Data Files to a Device — 
Put

You can return a device setting data file held in System Manager to the original 
device, or transfer it to a similar device.
Use the following procedure.

1 In the System Manager folder display/file list, select the folder/file you 
want to transfer to the device.

Here, by way of example, the DME channel 1 snapshot data file is selected.

2 In the Data LAN folder display, select the data destination.

In place of directly selecting a file or the folder containing, you can also 
select (the topmost folder for) a device.

3 Click the Put button.

A Confirmation window appears.

Device
Transferring Device Setting Data Files to a Device — Put
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4 Click the  button in the Confirmation window.
(To cancel the operation, click the  button.)

The transfer starts, and the Confirmation window changes to a Put window 
showing the progress of the transfer.

When the transfer is completed, the Put window automatically closes.

To cancel the transfer after it has started
Click the  button.
49Transferring Device Setting Data Files to a Device — Put
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Overview

The Switcher Setup Software (BZPS-8001) is a tool allowing you to carry out 
operations in the switcher menus, using a computer in place of a center control 
panel. You can access not only the Engineering Setup menu, but also many 
other menus supported by the switcher, to carry out operations remotely.
By displaying the desired menu screen on the computer monitor, you can use 
the mouse and keyboard for efficient setting operations.

Starting the Switcher Setup Software

To start the Switcher Setup Software, use the following procedure.

1 In the System Manager Main Menu window, select Switcher Setup.

The Switcher Setup window appears. (See the section, “Names and 
Functions of Parts of the Switcher Setup Window” on page 53.)

When there is more than one control panel with a registered IP address 
in the network
51Overview
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To select the control panel, a Choose Control Panel dialog box appears. In 
this case, continue to step 2.

2 In the drop-down list, select the control panel, and Click the Open Panel 
button.

Note 
The drop-down list shows control panel identifiers or similar entered in the 
Description column of the list of devices in the Device Monitor window.

The Switcher Setup window appears. (See the section, “Names and 
Functions of Parts of the Switcher Setup Window” on page 53.)
Starting the Switcher Setup Software
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Names and Functions of Parts of the Switcher Setup Window

a File
Click this to display the File menu. The File menu provides 
the following commands.
About: Shows version information for the Switcher Setup 

Software, and menu (GUI) version information.
Close: Closes the Switcher Setup window, and exits the 

Switcher Setup Software.

b Window
Click this to display the Window menu. The Window 
menu provides the following command.
New: Opens a window to display a switcher menu.

1 File

Menus corresponding to buttons 
displayed in dark gray cannot be operated 
from System Manager.

2 Window

3 Top menu selection buttons

Menus corresponding to buttons 
displayed in light gray can be operated 
from System Manager.
53Starting the Switcher Setup Software
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c Top menu selection buttons
These correspond to particular top menus on the switcher.
The colors of buttons (light gray and dark gray) indicate 
whether the corresponding menus can or cannot be 
operated.
Light gray: The corresponding menus are supported on 

the switcher, and can be operated from System 
Manager.

Dark gray: The corresponding menus cannot be operated 
from System Manager, even if they are supported on 
the switcher.

If at least one menu display window is open, clicking a 
light gray button opens a window displaying the 
corresponding menu.

Checking the Version

To check the version of the Switcher Setup Software and the switcher menus 
(GUI), in the Switcher Setup window File menu, select About.

The following version information window appears.

To close this window, click the  button or  button.

Exiting the Switcher Setup Software

To exit the Switcher Setup Software, in the File menu select Close, or click the  
 button.
Starting the Switcher Setup Software
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Displaying a Switcher Menu

To display a switcher menu, in the Window menu of the Switcher Setup window 
select New.

This opens a menu display window, and the Engineering Setup menu (menu 
number 7311) appears.

Displaying a different menu
When the window displaying the Engineering Setup menu opens, the color of 
the ENG SETUP top menu selection button in the Switcher Setup window 
changes from light gray to orange.
Displaying a Switcher Menu
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In this state, clicking a light gray button opens a window to display a new menu, 
and the menu corresponding to the button appears.
For example, click the KEY FRAME button to display the KEY FRAME menu.

The KEY FRAME button changes to orange, and the ENG SETUP button 
returns to light gray.

In this way, you can display a maximum of four menus.

Menu operations
When a menu window is active, you can carry out operations in the displayed 
menu.
When only one window is opened, this window is always active. If more than 
one window is opened, click the corresponding top menu selection button, 
turning it orange, or click anywhere in the desired window other than the  
button or  button.

The orange color 
indicates that the menu 
corresponding to this 
button is currently 
displayed, and the 
display window is active.
57Displaying a Switcher Menu
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For details of operations in particular menus, refer to the User’s Guide for the 
switcher.

Numeric keypad window
When inputting parameter values and so on, in addition to the computer 
keyboard, you can use the numeric keypad window.
For example, in the Color Bkgd menu, when you click the knob parameter 
button Hue to set the value of the Hue parameter, a numeric keypad window 
appears as shown in the following figure. You can click on buttons of the 
numeric keypad using the mouse to enter a numeric value. By dragging the 
slider at the bottom to left or right, you can also continuously vary the value. 
You can use this slider in place of the adjustment knobs on the center control 
panel.

For details of the operation of buttons in the numeric keypad window, refer to 
the User’s Guide for the switcher.

To close the numeric keypad window
Click the Close button.

Keyboard window
To input file names and so on, in addition to the computer keyboard, you can 
use the keyboard window. When you carry out an operation that requires 
character input, the keyboard window automatically appears.

Numeric keypad window

Slider
Displaying a Switcher Menu
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For details of the buttons in the keyboard window, refer to the User’s Guide for 
the switcher.

For details of limits on the number of characters that can be entered for file 
names, signal source names, and so on, refer to the User’s Guide for the 
switcher.

To enter capital letters
• To enter capital letters with the keyboard window, click the Shift button, 

turning it on, then click the button for the letter. Repeat this for each character.
If you click the Caps Lock button, turning it on, then you can enter a sequence 
of capital letters.

• When using the computer keyboard, by holding the Shift key down you can 
enter a sequence of capital letters, but the Caps Lock function does not work. 

To close the keyboard window
Click the Close button.

Closing the menu window
To close the menu window, click the  button in the top right corner of the 
window.
59Displaying a Switcher Menu
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